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APPENDIX A
TROUBLESHOOTING

This appendix provides help for solving problems in BERNINA 
Embroidery Software. It includes procedures for checking 
your system’s requirements and settings, reverting to 
original values, and testing disks and connections. It also 
describes how to log errors, and lists causes for common 
error messages and problems.

Solving problems in BERNINA 
Embroidery Software

If you encounter a problem, refer to the following 
sources for help:

BERNINA Embroidery Software Reference Manual 
– select Help > Reference Manual (or printed 
version)

BERNINA Embroidery Software Online Help – 
select Help > Help Topics

MS Windows® Online Help – select Start > Help

MS Windows® manual

Documentation supplied with your hardware.

Getting help

If you are unable to solve a problem, you should 
contact your dealer. Before seeking help, check that 
your PC meets the system requirements, and check 
the Security device messages and General problems 
sections in this chapter.

Reverting to factory settings

If you have made changes to the default settings in 
your software and you want to revert to factory 
settings, use the Revert utility.

To revert to factory settings

1 Exit BERNINA Embroidery Software.

2 On the MS Windows® Taskbar, click the Start 
button and select Programs > BERNINA 
Embroidery Software 7 > BERNINA 
Embroidery Software 7 Tools > Revert. 

The Revert to Factory Settings dialog opens.

3 Select the items you want restored to factory 
defaults.

Note  Reverting to the original settings removes 
any changes you have made to styles, templates 
and hardware settings.

4 Click OK. 

The selected items are restored to factory settings. 

Note  There is no confirmation message.

PC specifications

Check that your PC meets the system requirements. 
Check CPU/RAM as well as hard disk space. The table 
below provides minimum system requirements.

Item Minimum

CPU Intel® Pentium® 4, AMD Athlon™ 64 
or AMD Opteron™
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Supported operating systems ‡

Although Windows XP (32bit) is supported, 
BERNINA highly recommends that you consider 
updating to Windows 7 or Windows 8.

Free hard disk space † 

BERNINA Embroidery Software occupies up to 1Gb of 
hard disk space, depending on the options installed.

Screen resolution ¥
Some controls may be hidden on the user interface if 
you run your monitor at low resolutions. The physical 
size of your monitor will have a bearing on the 
optimum screen resolution. Larger fonts will 
exacerbate the problem. If you experience visibility 
issues, try adjusting both screen resolution and font 
size. For example, a resolution of 1280 x 720 with a 
font size of 100% or 125% should be acceptable.

Checking CPU/RAM specifications

Check your CPU and RAM specifications, and the 
version of MS Windows® you are running to ensure 
they meet the BERNINA Embroidery Software 
requirements. See PC specifications for details.

To check CPU/RAM specifications

1 On the MS Windows® desktop, right-click the My 
Computer icon and select Properties.

The System Properties > General dialog opens.

2 Check the MS Windows® version, the CPU and the 
amount of RAM. 

Checking your hard disk space

Check that your hard disk has enough space to run 
BERNINA Embroidery Software effectively. See PC 
specifications for details.

To check your hard disk space

1 Double-click the My Computer icon on your 

MS Windows® Desktop.

The My Computer window opens.

2 Right-click the hard-disk drive icon (usually C:) 
and select Properties.

The Properties > General dialog opens.

This tab shows the hard-disk capacity as well as 
any free space. This must be greater than 100 Mb 
or 10% of your total hard drive space, whichever 
is the greater amount.

Reconnecting BERNINA Portfolio to 
BERNINA Embroidery Software

Occasionally BERNINA Portfolio may fail to connect 
with BERNINA Embroidery Software. Follow the steps 
below to track down the problem.

To reconnect BERNINA Portfolio to BERNINA 
Embroidery Software

1 Check that your dongle security device is 
connected.

2 Close down BERNINA Embroidery Software, 
reopen it, then open BERNINA Portfolio.

3 If the problem persists, re-install BERNINA 
Embroidery Software.

Recovering from hardware or software 
failure

If your software crashes due to a hardware or 
software failure, recovery files are usually created. 
When you restart BERNINA Embroidery Software 
after such a failure, the design you were last working 
on is opened automatically or, if Auto Save was on, 

OS ‡ Windows® XP SP3 (32-bit)

Browser I.E. 7.0 or later

Internet 
connection

Required for installation, product 
registration and access to software 
updates.

Memory 1 GB (32-bit) or 2 GB (64-bit)

Hard disk 
size

40 GB

Free disk 
space

† 20 GB

Graphics 
card

Support for Highest Color (32bit) and 
resolution 1280 x 1024

Monitor ¥ 17" at native resolution of 1280 x 
1024

Scanner, 
printer and 
plotter

Windows-compatible (any 
connection method – e.g. parallel, 
USB)

USB ports Dedicated USB port for a USB 
dongle

Mouse USB mouse

Data drives DVD-ROM drive for software 
installation

Sound card Required for multimedia training

Item Minimum
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the backup file is retrieved. If a recovery file is 
opened, save the file to a new name with the ART 
extension.

Note  Do not save to the Backup folder or it will be 
deleted.

Once your recovery file has been saved and re-named 
with the ART extension, delete the recovery files.

To recover from hardware or software failure

1 Open MS Windows® Explorer.

2 Open the ..\Program Files\BERNINA\Embroidery 
Software 7 folder.

3 Open the Backup folder.

4 Select a BAK file and right-click.

5 Select Rename from the pop-up menu.

6 Change the BAK extension to ART.

7 Start BERNINA Embroidery Software.

8 Open the new file in BERNINA Embroidery 
Software.

9 Save As to a different location, not the Backup 
folder.

Unrecoverable errors

Deleting files with Delete Recovery

You can delete corrupt files using the Delete 
Recovery utility. Delete Recovery deletes files in 
the C:..\Program Files\BERNINA\Embroidery 
Software 7\Recover and C:..\Program 
Files\BERNINA\Embroidery Software 7\Backup 
folders. You should also periodically delete the backup 
files created by Auto Save.

Note  Some files such as MLG and DMP files can build 
up over time and take up disk space. You can delete 
them manually from MS Windows® Explorer.

To delete files with Delete Recovery

1 Exit BERNINA Embroidery Software.

BERNINA Embroidery Software must be closed 
before deleting recovery or backup files or it will 
NOT delete these files.

2 On the MS Windows® Taskbar, click the Start 
button, and select Programs > BERNINA 
Embroidery Software 7 > BERNINA 
Embroidery Software 7 Tools > Purge 
Recovery. 

The Purge Recover and Backup Directories 
dialog opens.

3 Select Delete Backup Files if you want to delete 
back up files.

4 Click OK. 

If some files cannot be deleted, a message will 
display. Delete these files from the C:..\Program 
Files\BERNINA\Embroidery Software 7\Recover 
and C:..\Program Files\BERNINA\Embroidery 
Software 7\Backup folders manually, from 
MS Windows® Explorer. 

Tip  If the errors persist, try reverting to factory 
settings. See Reverting to factory settings for 
details.

Problem The system fails and displays ‘unrecoverable’ 
error. 

Cause The design you tried to open is corrupt.

Suggestion Delete any files in the C:..\Program 
Files\BERNINA\Embroidery 
Software 7\Recover folder using the Purge 
Recovery utility, or manually via 
MS Windows® Explorer, then restart 
BERNINA Embroidery Software. You can 
also delete files using MS Windows® 
Explorer. See Deleting files with Delete 
Recovery for details.
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Security device messages

This section describes the messages related to the 
security device. Most security device messages are 
caused by incorrect connection, access codes, 
interference or conflict from another hardware device 
on the PC.

To prevent security device errors, enter all access 
codes as soon as you receive them. If you skip any 
access codes, features may become unavailable, or 
BERNINA Embroidery Software may stop working 
altogether. See Installation Notes for details.

Invalid Access Code

Invalid product

General problems

The following section refers to general problems you 
may experience with your designs.

Inconsistent output results

Missing toolbar buttons

Resolving Exception Access Violation 
errors

The error message ‘Exception Access Violation’ can 
appear when zooming, using lettering, printing or 
scanning, saving designs, or viewing the Color Film. 
This problem generally relates to the display adapter 
driver and/or the display adapter itself. Try each of 
the following solutions in sequence.

Exception access violation at startup

Other exception setting violations

Message Invalid Access Code

Cause • The access codes you are trying to enter 
are incorrect for your security device.

• You are missing a set of codes.

Suggestion Check the ID code on the access code sheet 
to see whether it matches the ID code in the 
Security Dialog. If they do not match, note 
your security device Serial Number and 
current ID code and contact your distributor.

Message Invalid product

Cause The security device cannot be found, or is 
damaged.

Suggestion Check the installation of the security device to 
ensure it is fitted correctly. Contact your 
distributor with your Dongle Serial Number.

Problem Problems when sending designs to 
embroidery machines for stitching. 
Inconsistent reading and writing.

Cause Serial or USB communications problems. 
Inconsistent reading and writing may be 
caused by wrong port settings in the 
operating system. 
Other possible causes are that machine and 
software versions may not be compatible. In 
this case, contact your dealer.

Suggestion Change the port settings. 

Problem Buttons missing from toolbars or bottom of 
toolbars.

Cause Screen resolution is set too low.
Virus in computer.

Suggestion Change the screen resolution to 1024 x 768 
or higher.
Run your virus checker.

Problem An ‘Exception Access Violation’ error 
message appears when starting BERNINA 
Embroidery Software.

Cause A corrupt design file in the RECOVER folder 
or a corrupt ..\Program 
Files\BERNINA\Embroidery 
Software 7\RES\defaults.dfl file.

Suggestion Delete any files in the .....\Program 
Files\BERNINA\Embroidery 
Software 7\RECOVER folder. If BERNINA 
Embroidery Software still will not start, use 
MS Windows® Explorer to copy the default 
...\BIN\defaults.dfl file to the ...\RES folder, 
overriding the corrupt defaults.dfl file. This will 
reset BERNINA Embroidery Software to ‘new 
installation’.

Problem An ‘Exception Access Violation’ error 
message appears when zooming, using 
lettering, printing or scanning, saving designs, 
or viewing the Color Film.

Cause This problem generally relates to the display 
adapter driver and/or the display adapter itself.

Suggestion Try each of the listed solutions in sequence. 
See  for details. See also Resolving Exception 
Access Violation errors.
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APPENDIX B
TIPS & TRICKS

This appendix provides tips and tricks for getting the 
most out of your BERNINA Embroidery Software in 
combination with your BERNINA embroidery 
machine. It includes tips for stabilizing designs, 
hooping, thread and needle recommendations, 
lettering and appliqué, stitch quality, design 
management, and many others.

Tips and tricks

Add fabrics to appliqué designs created in the 
software.

Add hoops to your software by specifying new 
sizes in Hoop options and saving them for later 
use.

Adjust stitch width and spacing of blanket stitching 
on your appliqué designs.

Remember to save while working. Start off with a 
‘Save As’ as soon as you open a design so that you 
don’t mistakenly save over the original.

Always do a test sew-out on a similar fabric, 
stabilizer, and thread, before embroidering of your 
final design.

Always print your design template using a hoop 
that includes the x-y axis. This provides reference 
points - start and center point – to verify the 
design position on the machine.

Appliqué can be done as a trim-in-place or pre-cut.

Ball Point needles should be used on knit fabrics. 
The slightly rounded needle tip will slip between 
the knit fibers and keep it from making runs or 
holes.

Bernina artista machines and the 830 allow you to 
wind extra bobbins while embroidering.

Click an object to select it, or hold down the #2 key 
while clicking to cycle through layered objects.

Create advanced appliqués with the advanced 
open-object Advanced Appliqué function.

Digitize reference lines to help position designs. 
Use lines saved with the template to position 
designs accurately on the project. 

Don’t stretch fabric when placing in the hoop. 

Don’t forget the underlay. Underlay attaches the 
fabric to the stabilizer to further stabilize the 
design. BERNINA Embroidery Software V7.0 
automatically adds underlay to both automatically 
digitized and manually digitized designs.

You can preset underlay settings before you 
digitize. 

Quickly send designs to your Bernina embroidery 
machines using File/Card Machine Write or the 
Write to Machine tool.

For proper placement of a left chest design, lay 
your garment on a flat surface. Draw imaginary 
lines down from the top of the shoulder, then 
across through the middle of the sleeve. The 
center should be where the two lines intersect.

Grade ‘A’ art files will retain their integrity when 
resizing and give more editing possibilities.

If the start point is in the design center, select 
Arrange > Start and End to move it to the best 
reference point for perfect placement on the 
machine.

If positioning manually, digitize a boundary line 
around the inside of the hoop. As the embroidery 
machine auto-centers, the boundary line will keep 
your arrangement in position. Simply skip the 
boundary line when stitching out. 

Press the (.) key to see all needle points in a 
design.
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It’s easy to convert a Satin appliqué to a Blanket 
stitch. 

Large letters work better if the density is a little 
higher, whereas small letters work better at lower 
density.

Lettering doesn’t have to be Satin stitching. If it is 
to be stitched onto a gym bag or similar high-use 
item, consider changing the stitch type to, say, 
Step. 

Make sure the inner hoop is all the way into the 
outer one. The inner should be flat on the machine 
bed in order to form a proper stitch.

Marking placement lines on your fabric or project 
is important. Make sure your project is always 
hooped straight. 

Once you have created your appliqué shape(s), 
the software will automatically create placement 
line, tack down, and cover stitching with color 
stops. 

Polyester embroidery thread is stronger than 
rayon thread and is colorfast, chlorine bleach 
resistant, UV resistant and will not take on other 
colors or bleed onto your project.

Portfolio is a great tool for organizing designs in 
many formats. 

Portfolio allows you to view your designs several 
ways: design only, design with details, and list. 

Portfolio allows you to sort designs by name, size 
and date. 

Portfolio allows you to print a design catalog 
showing all designs on your computer. 

Portfolio allows you to zip and unzip designs. 

Portfolio allows you to batch convert your designs.

You can send multiple designs from Portfolio to 
your embroidery machine.

You can insert multiple designs directly from 
Portfolio.

Print out the appliqué pattern when using the tools 
in artista for cutting appliqué fabric shapes.

Scan pictures into the software and create 
decorative embroidery frames around them. 

Press the Escape key to deselect any current 
selection in the software.

Slow Redraw simulates the actual design stitchout. 
With BERNINA Embroidery Software V7.0, you can 
set the stitch number to begin from.

Stabilizing is the most important issue with 
embroidery. Your dealer has lots of information 
about choosing the right type of stabilizer for your 
embroidery projects.

The Onscreen Manual has a list of shortcut keys to 
make using the software faster.

The Blackwork Run tool makes outlining your 
design a snap. It automatically eliminates jump 
stitches by resequencing the stitching.

BERNINA Embroidery Software V7.0 will 
automatically digitize TrueType fonts.

The Remove Appliqué Overlaps tool will remove 
overlapping appliqué stitches. 

The Polygon Select tool lets you easily select a 
portion of a design. 

The Remove Overlaps tool works to remove excess 
stitching under objects or lettering.

The Stitch Resequence feature will give you the 
best sewing sequence, fewer color changes, and 
fewer hoopings.

There are 30 Step Fill types.

There are 55 fonts in EditorPlus and 70 fonts in 
DesignerPlus.

There are several ways to get designs from 
computer to your machine: direct connection, via 
BERNINA USB stick, or using a Personal Design 
Card.

To check if you have the right needle, pierce the 
fabric with the needle. It should go in easily and 
shouldn’t leave a hole. A smaller rather than larger 
needle may be needed for denser designs.

To keep your embroidery machine running 
smoothly, always keep it clean. Follow the 
manufacturer’s instructions for cleaning and oiling. 
Take your machine in for service when needed. If 
you take care of it, it will take care of you.

To place a design on the center front of a garment, 
use the sleeves as your guide. Fold the shirt down 
the middle to get the vertical placement, then use 
the center of the sleeves as your horizontal 
placement. 

To select a design color, select the color chip in the 
Color Film dialog. To view just that color, select 
View > By Color.

Try a new colorway to perk up an old design. Do a 
design in a single color, or scale it back from many 
to only two or three colors. You’ll get a totally 
different look. Use the new Color Wheel tool to test 
new colors. New thread colors will automatically be 
assigned to the design.

Turn the hoop off when positioning multiple 
designs to avoid the distraction of watching it 
‘move’ as you add to the composition. When 
satisfied with the design arrangement, turn the 
hoop on to verify that the design fits within the 
embroidery field.
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Undo is your friend – you can undo up to 256 times 
or to the last save.

Use the ‘hoop relocator’ for easier threading on the 
embroidery machine.

Use the Alignment tools to align selected objects to 
left, right, top, bottom, or center of the last object 
selected.

Use the Multiple Spool Holder to ensure optimal 
threading of various brands of embroidery thread. 
The Multiple Spool Holder also allows you to view 
the colors you will use for the design.

When using the Wreath tool, you can merge any 
overlapping objects, making the two objects into 
one. 

Use the Wreath tool with alphabets and numbers 
to create fun designs.

When copying and pasting a design be sure to 
group it first. Check the Color Film for duplicate 
copies and eliminate them by pressing the Delete 
key.

When stitching embroidery on stretchy fabric, 
always use cut-away stabilizer to stabilize the 
fabric. 

When embroidering on towels or anything with a 
nap, a topping should be used - generally a 
water-soluble one. This will keep the ‘pokies’ from 
coming through the embroidery as well as keep 
stitches on top of the fabric.

When embroidering small lettering, use the 
smallest needle possible for smoother edges and 
easier reading.

When the embroidery is finished, cut or tear away 
excess stabilizer by holding the project in your lap 
toward you. This will help you avoid those ‘V’ 
slashes in the project when you can’t see it while 
removing the tear-away.

When removing the excess tear-away, hold onto 
the stitches and don’t tear into them. Remember 
it’s tear ‘away’ not tear ‘into’.

When trimming the bobbin thread, don’t trim it too 
close. Leave a little tail. This will keep stitches in 
front from coming loose. If they are close together, 
leave them alone – don’t trim at all.

Whenever possible, always hoop the project and 
stabilizer together in the hoop. 

With Color Film you can change the stitch order of 
your design. 

With Color Film you can easily change design 
colors. 

With Color Film you can view the design 
color-by-color. 

With Elastic Lettering you can create unique 
lettering styles.

With Arc Baselines you can set the lettering radius. 

You can adjust letter kerning, creating more or less 
space between letters – helpful especially when 
using a lower arc baseline.

You can apply pull compensation to an object.

You can change entry and exit points of an object 
simply by moving the green diamond (entry) and 
the red plus (exit) icons when using the Reshape 
tool.

You can make a quick quilt label using the 
Rectangle tool and selecting from the many 
pattern outlines, then adding your message. The 
monogram program is also great for making 
labels.

You can manually set Blanket stitch width and 
spacing through Object Properties.

You can set or change the stitch angle of a fill 
through Object Properties.

You can view what each font looks like together 
with recommended min and max sizes in your 
Onscreen Manual. Print these pages out for quick 
reference.

Your Onscreen Manual is found under the ‘Help’ 
menu.

Stitch count is displayed in the bottom right corner 
of the screen along with the height and width of 
design.
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ОБРАЗЦЫ АЛФАВИТОВ 

------------------------------------------- 
 
 
 
Образцы алфавитов для вышивания, приводимые в этом приложении, являются составной 
частью вашей программы BERNINA Embroidery Software, но не все виды входят в состав 
каждого уровня. 
 
Для получения самых лучших результатов при вышивании не выходите за пределы 
рекомендуемых максимальных и минимальных размеров, указанные для шрифта каждого 
алфавита. Имейте в виду, что рекомендуемые максимальные высоты относятся к буквам 
ЗАГЛАВНЫМ (ВЕРХНЕГО РЕГИСТРА). Большинство вышивальных алфавитов оцифрованы на 
основе некоторого шрифта типа TrueType Font (TTF), некоторые из которых имеют прописные 
буквы (нижнего регистра, например, а или с) составляющие по высоте примерно 70% от высоты 
заглавных букв.  В результате такие буквы могут оказаться слишком маленькими для 
вышивания при минимальных размерах. Может потребоваться несколько увеличить размер 
прописных букв, чтобы они хорошо вписались в вышивку.  
  
Указания по применению вышиваемых алфавитов см. в разделе Добавление текста к 
проектам вышивки. 
Для получения самых лучших результатов всегда проверяйте правильность выбора типа 
стабилизирующих стежков. 
Кроме стабилизации, стабилизирующий слой стежков помогает как-бы “приподнять” буквы над 
тканью. Требуемый тип стабилизирующего слоя определяется размером вышиваемых букв.  
Для мелких, узких букв стабилизирующие стежки могут не потребоваться, в зависимости от 
размеров букв и вида материала, на которых они будут вышиты.  
Если используются автоматические стабилизирующие стежки, они будут видны за пределами 
колонок вышивки. Для букв с размерами менее 5 мм применять стабилизирующие стежки не 
следует. Для букв с размерами от 6 мм до 10 мм можно использовать центрованные 
стабилизирующие стежки. Для букв с размерами более10 можно использовать краевые 
стабилизирующие стежки.  
См. также Стабилизация ткани стежками и Отключение функции автоматической 
стабилизации ткани для мелких букв. 
 
Совет: Вы можете создавать специальные символы из любого алфавита, удерживая нажатой 
клавишу Alt на клавиатуре и набирая 0 (ноль) и код символа на цифровой клавиатуре. 
Например, чтобы выбрать è с кодом 234, наберите Alt + 0234. Символ появится, как только вы 
отпустите клавишу Alt. В таблице символов вы найдете коды для всех символов. 
 См. также Добавление специальных шрифтовых знаков. 
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Abby Script

Abby Script is a traditional one-color script alphabet. It is great for names. Use 
extra pull compensation at smaller sizes.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.50 in 13 mm
Maximum 2.8 in 70 mm
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Alice

Alice is a traditional decorative style suitable for initials/monograms and 
personalization.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.32 in 8 mm
Maximum 2.0 in 50 mm
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Anniversary

Anniversary is a stylish script with fine curves and flourishes. It is popular for 
personalizing garments. Use extra pull compensation at smaller sizes.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.50 in 13 mm
Maximum 3.0 in 75 mm
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Bamboo

Bamboo is an oriental style alphabet. It can be used as a decorative alphabet 
by restaurants or martial arts clubs to convey an Asian influence.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.32 in 8 mm
Maximum 1.6 in 40 mm
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Blackboard

Blackboard is a classic serif-style alphabet. It has been popular for many years 
and is common in logos and educational designs.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.32 in 8 mm
Maximum 2.0 in 50 mm
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Bodoni

Bodoni is a classic, high-contrast alphabet best suited to larger sizes or with 
very stable fabric.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.3 in 7 mm
Maximum 2.0 in 50 mm
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Border-CAPS

Border-CAPS is a two-color block alphabet. It is used on sporting, school or 
college wear.

Alphabet contains Characters A - Z (caps only), 0 - 9, punctuation and sym-
bols, and European/special characters

Colors 2 color

Stitching Satin

Recommended letter height
Minimum 0.5 in 13mm
Maximum 1.5in 38mm
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Broadsheet

Broadsheet has a Satin outline around the outside edge of the letter shapes. 
The letters have solid, heavy appearance, with a serif-effect. This alphabet 
should be used in larger sizes.

Alphabet contains Characters A - Z (caps only), 0 - 9, punctuation and sym-
bols, and European/special characters

Colors 1 color

Stitching CAPS - Satin

Recommended letter height
Minimum 1.2 in 30 mm
Maximum 3.0 in 75 mm
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Castle

Castle is a classic romantic alphabet suitable for monograms or to convey a 
medieval or old world feel to restaurants or advertising material.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.75 in 10 mm
Maximum 1.6 in 40 mm
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Centurion

Centurion is a compact alphabet with strokes curving into serifs perpendicular 
to the letter strokes. It is more suited to medium-larger sizes. 

Alphabet contains Characters A - Z, a - z, 0 - 9, Punctuation and symbols, 
European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.5 in 13 mm
Maximum 2.4 in 60 mm
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Chicago

Chicago is a modern very squarish athletic-style alphabet, with half-serifs. Its 
solidity makes it well suited to large lettering on heavier fabrics, such as 
athletic wear and jeans.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.25 in 6 mm
Maximum 3.0 in 75 mm
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Childs Play

Childs Play is a fun alphabet, styled on children’s handwriting.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.5 in 13 mm
Maximum 1.2 in 30 mm
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Christopher

Christopher is a very rounded style. It suits children's wear, sportswear and 
modern designs.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.32 in 8 mm
Maximum 1.2 in 30 mm
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Craft

Craft is a modern narrow upright block, more suited for use on stable fabrics.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.4 in 10 mm
Maximum 2.0 in 50 mm
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Creative Cross

Creative Cross is decorative alphabet which can be used to embellish children’s 
wear. Capital letters include a design whereas the lower case letters are plain.

Alphabet contains Letters A - Z are letters with designs, a - z are letters only
Designs only on keys ! " # $ % & ' ( ) * + , - . / 01234567890

Colors Multi-color

Stitching Manual/cross stitches

Recommended letter height
Minimum 1.2 in 30 mm
Maximum 4.0 in 100 mm
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Croissant

Croissant is a specialist fancy style, giving a completely different look from 
most other alphabets. It is suitable for restaurants, homewear and other 
people-oriented designs.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.25 in 6 mm
Maximum 2.0 in 50 mm
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Cursive

Cursive is a basic script-style alphabet, with simply-formed capital letters. The 
thickness of the strokes is reasonably uniform, making this style usable across 
a wide range of sizes.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.28 in 7 mm
Maximum 2.4 in 60 mm
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Detex Normal

Detex Normal is a distinctive style. It has squarish letters in upper-case, with 
the effect of an open bar on the left size. It makes an attractive monogram.

Alphabet contains Characters A - Z, 0 - 9, Punctuation and symbols, Euro-
pean/special characters

Colors 1 color

Stitching CAPS - Satin

Recommended letter height
Minimum 0.35 in 9 mm
Maximum 2 in 50 mm
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Diamond2

Diamond2 is a special alphabet which includes two versions of each letter for 
left and right positions, plus a border and flourish for two-letter designs.

Alphabet contains

Left and Right letters for 2-letter monogram, 2 Borders as 
shown. To create a monogram, use upper case for the left 
letter, and lower case for the right letter, and either left 
square bracket [ or right square bracket ] for the border. 
For example, to create the first monogram shown above 
type Ab[.

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.7 in 18 mm
Maximum 4.0 in 100 mm

For left-hand letters, type uppercase For right-hand letters, type lowercase
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Diamond3

Diamond3 is a special alphabet which includes three versions of each letter for 
left, center and right positions, plus a border and flourish for 3-letter designs.

Alphabet contains

Left, Center and Right letters for 3-letter monogram, plus 
2 borders as shown. To create a monogram, use upper 
case for the left letter, the symbol key shown above for 
center letter, and lower case for the right letter, with either 
left square bracket [ or right square bracket ] for the bor-
der. For example, to create the first monogram shown 
above type A"c[.

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.7 in 18 mm
Maximum 4.0 in 100 mm

For left-hand letters, type uppercase

For right-hand letters, type lowercase
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Drifter

Drifter is a bold, relaxed style, with curves throughout. It has an Art Deco feel, 
and can be used in most situations.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.25 in 6 mm
Maximum 1.6 in 40 mm
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Easy Appliqué

Easy Appliqué makes appliqué letters which have uneven stroke width and 
rounded serifs. Each letter includes three stitching layers – first a placement 
line, then a zigzag tackdown, and finally a Satin cover stitch.

Alphabet contains Characters A - Z (caps only), 0 - 9, punctuation and sym-
bols, and European/special characters

Colors 1 color (cover stitch)

Stitching Appliqué

Recommended letter height
Minimum 1.2 in 30 mm
Maximum 2.8 in 70 mm



Appendix C : Alphabet Samples

BERNINA® Embroidery Software : Reference Manual 361

Eliza

Eliza is a one-color script alphabet designed for monogramming.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.8 in 20 mm
Maximum 3.2 in 80 mm
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Empress

Empress is an elegant calligraphic script style with a rich, classical look and 
small lower-case letters. It is reminiscent of wedding and similar invitations, 
and is suitable for gifts and special occasions.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.5 in 13 mm
Maximum 2.4 in 60 mm
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Energy

Energy is a fun, fast-paced style, which looks like quickly-written, hand-printed 
notes. It is suitable for larger lettering in youth-oriented designs.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.3 in 8 mm
Maximum 2.4 in 60 mm
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Erica

Erica is a graceful script alphabet based on Espania font and designed for 
monogramming.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.6 in 15 mm
Maximum 2.3 in 55 mm
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Felt Tip

Felt Tip is a Gothic alphabet in the style of historic English fonts. It can be 
applied to gifts and personalised items.

Alphabet contains
Characters A - Z, 0 - 9
Punctuation and symbols
European/special characters

Colors 1 color

Stitching Normal - Satin

Recommended letter height
Minimum 0.4 in 10 mm
Maximum 2 in 50 mm
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Flair Script

Flair Script is a graceful script with added flairs underneath. Flairs either fit 
snugly under the letters or are lowered to accommodate descenders. For Flair 
characters type keys as shown. Flairs can be for letters with or without 
descenders. For example, for the first example, type 4 abc[. See Adding flair 
script lettering for details.

Alphabet contains Characters A - Z, a - z, 0 - 9, Punctuation and symbols, 
Flair characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.75 in 10 mm
Maximum 3.2 in 80 mm
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Fortress

Fortress is solid block-style alphabet with simple clean lines. It is suitable for 
use on heavier fabrics.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.25 in 6 mm
Maximum 1.6 in 40 mm
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Greek

Greek is a classic serif-style. It is suited for educational institutions, 
restaurants, and events such as marriages and births in Greek communities.

Alphabet contains Greek letters, 0 - 9, and some punctuation and symbols

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.3 in 8 mm
Maximum 2.0 in 50 mm
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Greek Ionic

Greek Ionic is a san-serif style alphabet. As it is an easy to read alphabet, it 
can be applied to a wide range of personal and corporate uses in Greek 
communities.

Alphabet contains Greek letters, 0 - 9, and some punctuation and symbols

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.4 in 10 mm
Maximum 2.0 in 50 mm



Appendix C : Alphabet Samples

BERNINA® Embroidery Software : Reference Manual 370

Guinevere

Guinevere is based on the old writing styles of Welsh and Irish texts. It is 
decorative and suited for a wide range of uses such as souvenirs, linen, 
restaurants, some ethnic designs, etc.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.5 in 13 mm
Maximum 2.0 in 50 mm
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Hebrew 2

Hebrew 2 is a modern square Hebrew alphabet. It is a compact alphabet which 
can be applied to a wide range of uses in Hebrew communities.

Alphabet contains Hebrew letters, 0 - 9, and some punctuation and symbols

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.3 in 8 mm
Maximum 1.6 in 40 mm
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Hebrew David

Hebrew David is a modern Hebrew alphabet with rounded letters. As it is an 
easy to read alphabet, it can be applied to a wide range of uses in Hebrew 
communities.

Alphabet contains Hebrew letters, 0 - 9, and some punctuation and symbols

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.28 in 7 mm
Maximum 1.6 in 40 mm
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Helvetica Small

A variant of Helvetica, this alphabet is specifically created for use in small 
sizes.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.2 in 4 mm
Maximum 0.3 in 7 mm
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Hiragana

This is a special alphabet with Japanese Hiragana symbols for each letter.

Alphabet contains Japanese Hiragana characters. See print manual Alpha-
bets appendix for details of input keys.

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.50 in 13 mm
Maximum 2.0 in 50 mm
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Impact 3D

Impact 3D is a raised 3D alphabet to be stitch out with 3 mm thick foam only. 
It looks good if you follow the recommended lettering heights. It can be 
applied to items that don’t require frequent washing as this will tend to 
damage the foam.

Alphabet contains Characters A - Z, 0 - 9

Colors 1 color

Stitching Normal - Satin, additional underlay not required

Recommended letter height
Minimum 0.8 in 20 mm
Maximum 1.4 in 35 mm

Special
Foam 3 mm
Thread tension 
setting -2
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Island

Island is a bold script-style alphabet, with connecting lower-case letters. The 
thickness of the strokes is even throughout. It is popular and versatile. 

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.32 in 8 mm
Maximum 2.0 in 50 mm
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Jikharev

Jikharev is based on the Russian Cyrillic alphabet. It is easy to read and can 
be used for many purposes, both personal and corporate.

Alphabet contains Russian/Cyrillic letters, 0 - 9, and some punctuation and 
symbols

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.3 in 8 mm
Maximum 2.0 in 50 mm
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Katakana

This is a special alphabet with Japanese Katakana symbols for each letter.

Alphabet contains Japanese Katakana characters. See print manual Alpha-
bets appendix for details of input keys.

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.50 in 13 mm
Maximum 2.0 in 50 mm
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Ketchikan

Ketchikan is an ornate all caps alphabet which is commonly used for 
restaurant, clothing and other business names where style and fashion are 
important.

Alphabet contains Characters A - Z (caps only), 0 - 9, punctuation and sym-
bols, and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.3 in 8 mm
Maximum 1.2 in 30 mm
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Kindergarten Block

Kindergarten Block is a fun alphabet which has many applications for children’s 
wear. 

Alphabet contains Characters A - Z (caps only), 0 - 9, punctuation and sym-
bols, and European/special characters

Colors 1 color

Stitching CAPS - Satin

Recommended letter height
Minimum 0.4 in 10 mm
Maximum 3.6 in 90 mm
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King Charles

King Charles is a fancy alphabet style with proportionally large lower-case and 
long ascenders. It creates an old-style formal and elegant impression.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.32 in 8 mm
Maximum 2.0 in 50 mm
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Lazer

Lazer is a modern techno-style alphabet with rounded corners consisting only 
of upper case letters, small and large. It looks good when applied to modern, 
clean designs, particularly with a techno theme.

Alphabet contains Characters A - Z, a - z, 0 - 9, Punctuation and symbols, 
European/special characters

Colors 1 color

Stitching Normal - Satin

Recommended letter height
Minimum 0.24 in 6 mm
Maximum 2 in 50 mm
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Lisa

Lisa is a hand-writing style where lower-case letters join together. It is popular 
for monograms, but is not suitable for use with many capital letters together.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.50 in 13 mm
Maximum 3.0 in 75 mm
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London

London is an easy-to-read sans-serif style alphabet with large lower-case 
letters. The stylish look suits both corporate and personal text.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.32 in 8 mm
Maximum 2.0 in 50 mm
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Mandarin

Mandarin is an alphabet consisting of upper-case characters, with an Asian 
influence. It is used for Asian restaurants, martial arts clubs, etc.

Alphabet contains Characters A - Z (caps only), 0 - 9, punctuation and sym-
bols, and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.3 in 8 mm
Maximum 2.0 in 50 mm
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Medley

Medley has a hint of serif created by the flared ends of the strokes. It is very 
stylish, and suitable for masculine monograms. 

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.28 in 7 mm
Maximum 1.6 in 40 mm
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Meegan

Meegan is a one-color script alphabet designed for monogramming.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.6 in 15 mm
Maximum 2.2 in 55 mm



Appendix C : Alphabet Samples

BERNINA® Embroidery Software : Reference Manual 388

Micro Block

Micro Block has been designed for use specifically where small legible block 
letters is required.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.2 in 4 mm
Maximum 0.3 in 8 mm
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Microgramma

Microgramma is a slightly boxy, wide, sans-serif alphabet.

Alphabet contains Characters A - Z, a - z, 0 - 9, Punctuation and symbols, 
European/special characters

Colors 1 color

Stitching Satin

Default Letter Spacing 10%

Recommended letter height
Minimum 0.25 in 6 mm
Maximum 2.4 in 60 mm
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Neon-CAPS

Neon-CAPS is an alphabet which mimics the effect of neon lights. It can be 
used to give a modern hi-tech look in a wide variety of applications.

Alphabet contains Characters A - Z (caps only), 0 - 9, punctuation and sym-
bols, and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.7 in 18 mm
Maximum 3.0 in 75 mm
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Nightowl

Nightowl is a modern sans-serif alphabet with a noticeable italic slant and 
rounded ends. It is a popular style for advertising and designs with a carefree 
feeling.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.25 in 6 mm
Maximum 2.0 in 50 mm
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Olde English

Olde English is based on traditional medieval English calligraphy script. It is 
used for specialist lettering, and is especially popular for school, college and 
university badges.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.5 in 13 mm
Maximum 2 in 50 mm
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Phoebe Curls

Phoebe Curls is an ornamental capital-serif alphabet with floral background 
designed for monogramming.

Alphabet contains Characters A - Z (caps only)

Colors 1 colors

Stitching Satin

Recommended letter height
Minimum 0.6 in 15 mm
Maximum 1.4 in 35 mm
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Prestige

Prestige is a traditional block-style alphabet, popular for corporate logo work. 
It is quite bold and usually does not require additional pull compensation. It 
also works well with Elastic Lettering effects. See Creating ‘elastic lettering’ 
effects for details.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.2 in 5 mm
Maximum 2.0 in 50 mm
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Quilting Text

Quilting Text gives a feel of hand stitching and is used to personalize blocks in 
quilts. It is a very small alphabet made of simple running stitches, as it is 
required to be subtle and blend into the quilt.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Run stitching

Recommended letter height
Minimum 0.16 in 4 mm
Maximum 0.25 in 6 mm
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Racer

Racer is a streamlined script alphabet with emphasized balled top ends. It 
recalls the chrome-strip lettering used on industrial goods of the 1930s and 
40s, such as enamelled refrigerators and automobile trunks. It looks good 
when applied to racing and sporting uniforms.

Alphabet contains Characters A - Z, a - z, 0 - 9, Punctuation and symbols, 
European/special characters

Colors 1 color

Stitching Normal - Satin

Recommended letter height
Minimum 0.3 in 8 mm
Maximum 1.4 in 35 mm
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Roman-Small

Roman-Small is a variant of Times Roman, specifically designed for use in 
smaller sizes.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.2 in 4 mm
Maximum 0.25 in 6 mm
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Rounded Block

Arial Rounded is based on the widespread 20th century realist sans-serif.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.32 in 8 mm
Maximum 1.8 in 45 mm
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Run Cardigan

Run Cardigan is an outline or run alphabet based on Cardigan TrueType font. 
It gives a feel of hand stitching and is used to personalize blocks in quilts. It 
can also be used for quilting labels or other small text. See also Quilting Text.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.2 in 5 mm
Maximum 0.5 in 12 mm
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Run Freehand

Run Freehand is an outline or run alphabet based on Freehand591 TrueType 
font. It gives a feel of hand stitching and is used to personalize blocks in quilts. 
It can also be used for quilting labels or other small text. See also Quilting Text.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.2 in 5 mm
Maximum 0.5 in 12 mm
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Run Liberty

Run Liberty is an outline or run alphabet based on Liberty BT Regular TrueType 
font. It gives a feel of hand stitching and is used to personalize blocks in quilts. 
It can also be used for quilting labels or other small text. See also Quilting Text.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.2 in 5 mm
Maximum 0.5 in 12 mm
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Run Murray Hill

Run Murray Hill is an outline or run alphabet based on Murray Hill Regular 
TrueType font. It gives a feel of hand stitching and is used to personalize blocks 
in quilts. It can also be used for quilting labels or other small text. See also 
Quilting Text.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.2 in 5 mm
Maximum 0.5 in 12 mm
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Russian Textbook

As the name suggests, Russian Textbook is a standard textbook font based on 
Russian/Cyrillic letters, suitable for general use in logos, etc.

Alphabet contains Russian/Cyrillic letters, 0 - 9, and some punctuation and 
symbols

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.3 in 8 mm
Maximum 1.8 in 45 mm
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Scanner

Scanner has a modern, ‘hi-tech’ look. It is suitable for a wide variety of 
applications.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.28 in 7 mm
Maximum 1.6 in 40 mm
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Secret Garden-CAPS

Secret Garden-CAPS is a floral alphabet which can be used to decorate many 
items of clothing. Only the capital letters are embellished with flowers, the 
lower case letters are a plain sans serif.

Alphabet contains Letters A - Z (caps only), dash, and brackets

Colors Multi-color

Stitching Satin

Recommended letter height
Minimum 1.5 in 38 mm
Maximum 3.6 in 90 mm



Appendix C : Alphabet Samples

BERNINA® Embroidery Software : Reference Manual 406

Sm High Tower

Hightower was created by Tobias Frere-Jones for the Journal of the American 
Institute of Graphic Arts. Based on Nicolas Jenson’s 1470 Venetian roman font, 
Frere-Jones prepared his own version of this calligraphic roman font with his 
own personal italic in 1996. Sm HighTower is a variant of the italic font, 
specifically designed for use in smaller sizes.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.2 in 4 mm
Maximum 0.25 in 6 mm
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Speedy

Speedy is a bold, fast-paced modern alphabet.

Alphabet contains Characters A - Z, 0 - 9

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.3 in 8 mm
Maximum 1.2 in 30 mm
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Swiss Block

Swiss Block is based on Helvetica, the great all-purpose sans-serif alphabet. It 
is clean and simple, and suitable for any fabric.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.25 in 6 mm
Maximum 2.4 in 60 mm
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Tabloid

Tabloid has a Satin outline around the outside edge of the letter shapes. The 
letters have solid, heavy appearance, with a serif-effect. This alphabet should 
be used in larger sizes.

Alphabet contains Characters A - Z (caps only), 0 - 9, punctuation and sym-
bols, and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 1.2 in 30 mm
Maximum 3.0 in 75 mm
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Technical Block

Technical Block is a medium weight alphabet with squared serifs which stitch 
cross-ways. It is suitable for lettering in logos at a variety of sizes.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.32 in 8 mm
Maximum 2.0 in 50 mm
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Tiffany

Tiffany is an upright calligraphy script style where the letters do not join. The 
style is bold and extended, and suited for monograms, homewares, etc.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.28 in 7 mm
Maximum 1.4 in 35 mm



Appendix C : Alphabet Samples

BERNINA® Embroidery Software : Reference Manual 412

Times Small

Times Small is a variant of Times Roman, specifically designed for use in 
smaller sizes.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.2 in 4 mm
Maximum 0.25 in 6 mm
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Varsity Appliqué-CAPS

Varsity Appliqué-CAPS is a large alphabet suitable for making appliqué letters 
for college, school and university wear. Each letter includes three stitching 
layers – first a placement line, then a zigzag tackdown, and finally a Satin 
cover stitch.

Alphabet contains Characters A - Z (caps only), 0 - 9, punctuation and sym-
bols, and European/special characters

Colors 1 color

Stitching Appliqué

Recommended letter height
Minimum 1.2 in 30 mm
Maximum 3.0 in 75 mm
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Varsity Block-CAPS

Varsity Block-CAPS is a bold serif block alphabet. It is suitable for athletic-style 
lettering on garments, and for general use in logos, etc.

Alphabet contains Characters A - Z (caps only), 0 - 9, punctuation and sym-
bols, and European/special characters

Colors 1 color

Stitching Satin 

Recommended letter height
Minimum 0.25 in 6 mm
Maximum 1.4 in 35 mm
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Verdana

Verdana is a modern sans-serif alphabet that is very popular with web designs 
but lends itself to embroidery as a substitute, for example for Swiss Block.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.25 in 6 mm
Maximum 2.4 in 60 mm
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Victoria

Victoria is an opulent alphabet reminiscent of late 19th century stylings.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.4 in 10 mm
Maximum 2.0 in 50 mm
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Zurich

Zurich is based on one of the most popular calligraphy hand-written styles. It 
is often used in logos and is very popular for personalization.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, 
and European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.25 in 6 mm
Maximum Letters 60 mm
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ПРИЛОЖЕНИЕ D 

 

 
ОБРАЗЦЫ ЗАПОЛНЕНИЯ 

ПРОСТЕГИВАЮЩИМИ СТЕЖКАМИ 
------------------------------------------- 

 
Узоры заполнения простегивающими стежками, показанные в этом приложении, включены в 
вашу программу BERNINA. Указания об оконтуривании и заполнении узорами и об их 
использовании см. в разделе Создание заполнения простегивающим стежком. 
 
Примечание: Будьте уверены в том, что вы правильно выбрали угол орнаментных 
заполняющих стежков. В приводимых ниже образцах при оцифровывании был принят угол 
наклона стежков 0°. Поэкспериментируйте с разными углами наклона для получения новых 
эффектов. 
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ПРИЛОЖЕНИЕ E 

 

 
ОБРАЗЦЫ ЗАПОЛНЕНИЯ 

ОРНАМЕНТНЫМИ СТЕЖКАМИ 
------------------------------------------- 

 
 
Узоры заполнения орнаментными стежками, показанные в этом приложении, включены в вашу 
программу BERNINA. О заполнении орнаментными стежками и указания по их использовании 
см. в разделе Создание заполнения орнаментным стежком. 
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023 Oval (90)

024 Whirlpool 
(90)

025 Dance (90)

026 Heart (90)

027 Heart2 (90)

028 Valentine 
(90)

029 Scallop 
(90)

030 Shell (90)

031 Smile (90)

032 Flower (90)

033 Ribbon (30)

034 Sunny (90)

035 Shine (90)

036 Star (90)

037 Stardust 
(90)

ID & Angle Fancy Fill

038 Honey-
comb (90)

039 Beeswax 
(30)

040 Wave (90)

041 Dunes (0)

042 Chevron 
(90)

043 Chevron2 
(90)

044 Chevron3 
(90)

045 Wedge (90)

046 Crazy (90)

047 Arrow (20)

048 Weave (48)

049 Weave2 
(90)

050 Stream (90)

051 Bowtie (0)

052 Chain (90)

ID & Angle Fancy Fill
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053 Glitter (90)

054 Cross (45)

055 Double-
cross (90)

056 Galaxy (90)

057 Ring (90)

058 Ramble 
(90)

059 Florastar 
(90)

060 Stripes (90)

061 Letter A 
(90)

062 Letter B 
(45)

063 Letter C 
(90)

064 Letter D 
(45)

065 Letter E 
(45)

066 Letter F 
(45)

067 Letter G 
(45)

ID & Angle Fancy Fill

068 Letter H 
(45)

069 Letter I (45)

070 Letter J 
(45)

071 Letter K 
(30)

072 Letter L 
(45)

073 Letter M 
(45)

074 Letter N 
(45)

075 Letter O 
(30)

076 Letter P 
(45)

077 Letter Q 
(30)

078 Letter R 
(45)

079 Letter S 
(45)

080 Letter T 
(45)

081 Letter U 
(45)

082 Letter V 
(45)

ID & Angle Fancy Fill
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083 Letter W 
(45)

084 Letter X 
(90)

085 Letter Y 
(30)

086 Letter Z 
(30)

087 Paver (90)

088 Picasso 
(135)

089 Ziggy (0)

090 Spirali (90)

091 Manchu 
(45)

092 Grilles (45)

093 Wooden 
Lattice (82)

094 Han Line 
(45)

095 Dart (10)

096 T-frame 
(45)

097 Dou-
ble-arm (87)

ID & Angle Fancy Fill

098 Knuckled 
frame (45)

099 Tile (0)

100 Alarm Tile 
(83)

101 Turtle-back 
(79)

102 Stepped 
Wave (45)

103 Crayon (0)

104 Diamond 
Inlay (0)

105 Corduroy 
(0)

106 Diamond 
Punch (0)

107 Inlay Print 
(0)

108 Snowflake 
(0)

109 Inlay Maze 
(45)

110 Quilt Dia-
mond 1 (0)

111 Quilt Dia-
mond 2 (0)

112 Quilt Dia-
mond 3 (0)

ID & Angle Fancy Fill
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113 Zig-Zag 
Inlay (0)

114 Shell Inlay 
(0)

115 Music 1 (0)

116 Music 2 (0)

117 Four 
Square (45)

118 Symbol 1 
(45)

119 Symbol 2 
(50)

120 Symbol 3 
(82)

121 Wave 2 (0)

122 Wave 3 (0)

123 Honey-
comb 2 (45)

124 Rope (0)

125 Tree (142)

126 Wings 
(135)

127 Leaf (0)

ID & Angle Fancy Fill

128 Star (18)

129 Web (0)

130 Tear Drop 
(0)

131 2-way 
zig-zag (87)

132 Quilt 
Square 1 (45)

133 Quilt 
Square 2 (0)

134 Quilt 
Square 3 (0)

135 Quilt 
Square 4 (0)

136 Quilt 
Square 5 (45)

137 Quilt 
Square 6 (18)

138 Cloud Band 
1 (25)

139 Cloud 
Bands 2 (0)

140 Cloud 
Bands 3 (0)

141 Arrow 2 (0)

142 Rusty Ice 
(0)

ID & Angle Fancy Fill
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143 Ice Rays 
(0)

144 Dynasty (0)

145 Windwheel 
(0)

146 Tea Tray 
(0)

147 Cash Bars 
(45)

148 Chengtu (0)

149 Chihli (86)

150 Ming (135)

151 Arrowhead 
(89)

152 Basket2 
(40)

153 Bird (90)

154 Blocks2 (0)

155 Chain (90)

157 Circle (0)

158 Cube (48)

ID & Angle Fancy Fill

159 Ellipse (0)

160 Flame (90)

161 Jem (90)

162 Leaf (0)

163 Melody (0)

164 Metal (0)

165 Passage 
(0)

166 Piccolo (0)

167 Roma (0)

168 Rope (10)

169 Seville (0)

170 Star5 (10)

172 Tick (0)

173 Tile1 (135)

174 Tile3 (0)

ID & Angle Fancy Fill
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175 Vine (0)

176 Wave2 (90)

177 Wave3 (90)

178 Whirl (90)

179 Wild (48)

180 Xmastree 
(48)

ID & Angle Fancy Fill
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ПРИЛОЖЕНИЕ F 

 

 
УЗОРНЫЕ ШТАМПЫ, 

ОКОНТУРИВАНИЕ И ЗАПОЛНЕНИЕ 
УЗОРАМИ 

------------------------------------------- 
 
Ниже приведены узорные штампы, оконтуривание и заполнение узорами, которые включены в 
вашу программу BERNINA. .См. также в разделе Узорные штампы, оконтуривание и 
заполнение узорами. 
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Pattern set: Children

Pattern set: Corners

NP005-46

NP005-47

NP005-48

NP005-49

NP005-50

Name Pattern

901

905

907

909

910

911

914

Name Pattern

929

Name Pattern

Cnr001

Cnr002

Cnr003

Cnr004

Cnr005

Cnr006

Cnr007

Name Pattern
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Pattern set: Cross

Cnr008

Cnr009

Cnr010

Cnr011

Cnr012

Cnr013

Cnr014

Cnr015

Cnr016

Cnr017

Name Pattern

Cnr018

Cnr019

Cnr020

Name Pattern

301

302

303

305

309

311

313

b301

b302

Name Pattern
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Pattern set: Embellishment 
Pattern set: Heirloom

b303

b304

b305

b306

b307

 b308

b309

b310

Name Pattern

601

605

608

610

612

Name Pattern

614

618

623

629

637

641

644

648

653

Name Pattern

705

706

709

710

711

717

Name Pattern
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Pattern set: Home Dec

718

719

724

726

728

732

733

738

a701

a702

a703

a704

a705

a706

Name Pattern

Name Pattern

401

402

403

405

406

407

409

411

412

413

414

415

416

417

422
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Pattern set: Misc

424

425

426

427

429

430

431

a401

a402

a403

a404

a405

a406

a407

Name Pattern

a408

a409

Name Pattern

10

11

12

13

21

29

Star

3wave

Heart

Wedge

Blanket

Feather

Name Pattern
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Pattern set: Monogram Ornaments

Pinstit

Name Pattern

M001a

M001b M001a pattern oriented horizontally 
and mirrored

M002a

M002b M02a pattern oriented horizontally

M003a

M004a

M004b M004a pattern oriented horizontally

M005a

M005b M005a pattern oriented horizontally 
and mirrored

Name Pattern

M006a

M006b M006a pattern oriented horizontally

M007a

M008a

M008b M008a pattern oriented vertically

M009a

M009b M009a pattern oriented horizontally

M010a

M010b M010a pattern oriented horizontally

M011a

M011b M011a pattern oriented horizontally

M012a

M012b M012a pattern oriented horizontally

Name Pattern
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M013a

M013b M013a pattern oriented horizontally

M014a

M014b M014a pattern oriented vertically and 
mirrored

M015a

M015b M015a pattern oriented horizontally

M016a

M016b M016a pattern oriented horizontally

M017a

M018a

M018b M018a pattern oriented vertically

M019a

M019b M019a pattern oriented horizontally

Name Pattern

M020a

M020b M020a pattern oriented horizontally

M021a

M021b M021a pattern oriented horizontally

M022a

M022b M022a pattern oriented diagonally

M023a

M023b M023a pattern oriented horizontally

M024a

M024b M024a pattern oriented diagonally

M024c M024a pattern oriented horizontally

M025a

M025b M025a pattern oriented horizontally

Name Pattern
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M026a

M026b M026a pattern oriented horizontally

M027a

M027b M027a pattern oriented vertically

M028a

M028b M028a pattern oriented diagonally

M029a

M029b M029a pattern oriented horizontally

M030a

M030b M030a pattern oriented horizontally

M031a

M031b M031a pattern oriented horizontally

M032a

M032b M032a pattern oriented horizontally

Name Pattern

M033a

M033b M033a pattern oriented horizontally

M034a

M034b M034a pattern oriented vertically

M035a

M035b M035a pattern oriented horizontally

M036a

M036b M036a pattern oriented horizontally

M037a

M037b M037a pattern oriented horizontally

M038a

M038b M038a pattern oriented horizontally

Name Pattern
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M039a

M039b M039a pattern oriented horizontally

M040a

M040b M040a pattern oriented horizontally

M041a

M041b M041a pattern oriented horizontally

M042a

M042b M042a pattern oriented vertically

M042c M042a pattern oriented diagonally

M043a

M043b

M043c M043a pattern oriented horizontally

M044a

M044b M044a pattern oriented vertically

Name Pattern

M045a

M045b M045a pattern oriented horizontally

M046a

M046b M046a pattern oriented horizontally

M047a

M047b M047a pattern oriented horizontally

M048a

M048b M048a pattern oriented horizontally

M049a

M049b M049a pattern oriented horizontally

M050a

M050b M050a pattern oriented horizontally

M051a

M051b M051a pattern oriented diagonally

Name Pattern
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M052a

M053a

M054a

M055a

M055b M055a pattern oriented vertically

M056a

M057a

M057b M057a pattern oriented diagonally 
and mirrored

M058a

M059a

M059b M059a pattern oriented horizontally

M060a

M061a

M061b M061a pattern oriented horizontally

M062a

M062b M062a pattern oriented horizontally

Name Pattern

M063a

M064a

M064b M064a pattern oriented horizontally

M065a

M066a

M066b M066a pattern oriented horizontally

M067a

M067b M067a pattern oriented vertically

M068a

M069a

M069b M069a pattern oriented vertically

M070a

M071a

M071b M071a pattern oriented vertically

Name Pattern
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M072a

M072b M072a pattern oriented horizontally

M072c M072a pattern oriented diagonally

M073a

M073b M073a pattern oriented vertically

M073c M073a pattern bigger sized

M073d

M073e M073d pattern oriented vertically

M073f

M073g M073f pattern oriented horizontally

M073h

M073i M073h pattern oriented horizontally

M073j

M073k M073j pattern oriented diagonally

M073l M073j pattern oriented vertically

M074a

M074b
M074a pattern oriented hori-

zontally

M074a
M074a pattern oriented verti-

cally

Name Pattern

M074g

M075a

M075b

M075c M075b pattern mirrored

M075d M075b pattern oriented vertically

M076a

M076b M076a pattern oriented vertically

M077a

M077b M077a pattern oriented vertically

M078a

M078b M078a pattern smaller sized

M078c M078b pattern oriented vertically

M079a

M079b M079a pattern smaller sized

M079c M079b pattern oriented vertically

M080a

M080b M080a pattern smaller sized

M080c M080b pattern oriented vertically

M081a

M081b M081a pattern smaller sized

M081c M081b pattern oriented vertically

M082a

M082b M082a pattern oriented vertically

Name Pattern
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M083a

M083b M083a pattern oriented vertically

M084a

M084b M084a pattern oriented vertically

M085a

M085b M085a pattern smaller sized

M085c M085b pattern oriented vertically

M086a

M086b M086a pattern oriented vertically

M087a

M087b M087a pattern smaller sized

M087c M087b pattern oriented vertically

M088a

M088b M088a pattern oriented horizontally

M088c M088a pattern oriented diagonally

M089a

M089b M088a pattern oriented vertically

M089c

Name Pattern

M090a

M090b M090a pattern oriented horizontally

M090c M090a pattern oriented diagonally

M090d

M090e M090d pattern oriented vertically

M091a

M091b M091a pattern oriented vertically

M091c M091a pattern oriented diagonally

M092a

M092b M092a pattern oriented vertically

M092c

M092d M092e pattern mirrored vertically and 
horizontally

M092e M092e pattern mirrored horizontally

M093a

M093b M093a pattern oriented vertically

M093c

M093d M093c pattern oriented diagonally

M093e M093c pattern oriented vertically

M093f

M094a

M094b M094a pattern oriented vertically

M094c M094a pattern oriented diagonally

Name Pattern



Appendix F : Pattern Stamp, Run & Fill Samples

BERNINA® Embroidery Software : Reference Manual 441

Pattern set: NP004a

M095a

M095b

M096a

M096b M096a pattern oriented vertically

M096c

M096d

M097a

M097b M097a pattern oriented vertically

M097c

M097d M097c pattern oriented horizontally

M097e M097c pattern oriented diagonally

M098a

M098b M098a pattern oriented vertically

M098c

M098d M098c pattern oriented vertically

M099a

M099b M099a pattern oriented right

M099c M099a pattern oriented downwards

M099d M099a pattern oriented left

M099e M099a pattern oriented diagonally

Name Pattern

M0100a

M0100b M0100a pattern bigger sized

Name Pattern

K0001a

K0002a

K0003a

K0004a

K0005a

K0006a

K0007a

K0008a

K0009a

K0010a

K0011a

K0012a

Name Pattern
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Pattern set: NP005a

K0013a

K0014a

K0015a

K0016a

K0017a

K0018a

K0019a

K0020a

K0021a

K0022a

K0023a

K0024a

K0025a

K0026a

K0027a

A200026

A200150

A200446

A200602

Name Pattern

A200606

A200609

A200615

A200749

Name Pattern

151a

151b

152a

437a

660a

663a

701a

1023a

1024a

1026a

Name Pattern
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Pattern set: Nature

Pattern set: Quilting

1027a

Name Pattern

101

102

103

106

111

112

113

114

115

117

118

119

124

Name Pattern

129

135

136

Name Pattern

327

328

330

332

333

334

336

337

338

339

340

342

Name Pattern
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Pattern set: Satin-Quilt

343

a301

a302

a303

a304

a305

a306

a307

a308

a309

a310

a311

a312

a313

a314

a315

a316

Name Pattern

Name Pattern

501

503

506

507

508

509

511

512

513

514

515
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Pattern set: Carving Stamps

Name Pattern

0

 

1

2

3

4

5

6

7

8

9

A

B

C

D

E

F

G

H

I

J

K

Name Pattern
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L

M

N

O

P

Q

R

S

T

U

Name Pattern

V

W

X

Y

Z

Cylinder

Triangle

Ring_Half

Trapezoid

Arrow_3_Way

Arrow_4_Way

Name Pattern
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Arrow_Block

Ring_Ellipse

Parallelogram

Page

Tear

Arrow_4_Way_
Block

Arrow_Right_
Angle

Arrow_Double
_Block

Arrow

Cross

Flash

Name Pattern

Flame

Heart

Banned

Smiley

Arrow_Double
_Right_Angle

Polygon

Name Pattern
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ПРИЛОЖЕНИЕ G 

 

 
ОБРАЗЦЫ УЗОРОВ РУКОДЕЛЬНЫХ 

СТЕЖКОВ 
------------------------------------------- 

 
Образцы узоры рукодельных стежка, показанные в этом приложении, включены в вашу 
программу BERNINA. О применении рукодельных стежков (Craft Stitches) см. раздел 
Оконтуривание и заполнение рукодельными стежками. 
 
Узоры заполнения "Блэкуорк" 
Техника Blackwork (дословно "черная работа") 
получила свое название от черных шелковых 
ниток, используемых в этом виде вышивания. 
Узоры Blackwork можно использовать как для 
оконтуривания, так и для заполнения. В 
большинстве случаев при таком "черно-белом" 
заполнении используются простые стежки для 
создания комплексных геометрических узоров. 
См. разделы Создание контуров обрамления в 
технике "черной вышивки" ("блэкуорк") и 
Создание заполнений в технике "черной 
вышивки" ("блэкуорк"). 
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Узоры Candlewicking  
 
Вышивание узелковыми строчками 
(Candlewicking) является традиционной техникой 
вышивания "белым-по-белому", выполняемому 
обычно на белой льняной или 
хлопчатобумажной ткани толстыми 
хлопчатобумажными нитками. Узоры 
Candlewicking можно использовать как для 
оконтуривания, так и для заполнения. См. 
разделы Создание контуров обрамления 
стебельчатыми стежками и Создание 
заполнений строчками в технике candlewicking. 

 
 
 
Узоры кружевного 
переплетения 
 
Стежки кружевного переплетения образуют 
похожие на сетку узоры, которые придают 
объекту вид кружева.  Этот метод можно 
применять для объектов в виде замкнутых 
кривых или прямоугольников, заполняемых 
стежками с единым углом наклона. Подробнее 
см. в разделе Создание заполнения стежками 
кружевного переплетения. 
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